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Related
Resources

Arranging your Classroom for Effective Technology
Integration

Basic Seating and
Room Arrangement
Strategies-
http://www.learnnc.
org/newlnc/carepak.
nsf/292be0ea2a348
7608525692f0068d
504/2be2e2cf2a57
2e26852569370057
9ec9?0penDocumen
t

5 Computer
Classroom-
http://www.siec.k12,
in.us/~west/slides/i
ntegrate/sld015.htm

3-Computer
Classroom-
http://www.siec.k12,
in.us/~west/slides/i
ntegrate/sld016.htm

Other sample room
arrangements follow

One of the most basic components of a successful technology
infused lesson is the arrangement of the students and
technology in the classroom or computer lab. Listed below are
some things to consider when arranging your classroom for
effective use of technology.

o Make sure that students have enough space to complete
paper and pencil assignments near the computer.

o If usinga projection device with an entire class, make
sure that all students can see the monitor from their
desks.

o A computer on a cart needs to be easily moved from its
position to be used most effectively.

o If you plan to use groups of students working at
different stations, computers should be spaced around
the room so students are able to work effectively as a
group without interruptions.

a Furniture should be arranged to facilitate student and
teacher movement.

0 Make sure that you have room to store CD's, disks,
software and other computer related equipment.

Do not overload electrical outlets.
Post rules for using technology in a visible area.

o Keep computers away from windows to keep the glare
from sunlight of f the screens.

0 Make sure that the display on each computer faces the
classroom. Students will be more apt o stay on task if
they know that you might be looking over their shoulder.

o Keep computers in a low-traffic area where students do
not pass on their way into or out of the room.

o Cords and cables need to be properly contained out of
the reach of students.
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Sample Room Arrangements:

One Computer

|
teacher's desk
computer
computer
listening
cetter
qroup table
doar
|
teacher's desk
coputer
computer
listening
cetter
qroup table
door
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2 Computers
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5 Computers
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http://www.techle
arning.com/db_are
a/archives/WCE/a
rchives/paulalee.h
tm

Read about one
teacher'’s
successes and
failures managing
technology.

Stages of Utilizing
Technology-
http://www.geocit
ies.com/Athens/A
gora/2100/utliz3.
htm

This slide show
gives beginning
technology users
simple advice for
managing
computers in the
classroom.

Related Managing the Technology-Infused Classroom
Resources

Planning and preparing for a technology infused lesson is very
important, but good classroom management allows that lesson to
be carried out effectively. With good classroom management
strategies, students will be able to make the most of their

Managing technology experience.

Computers in the

Classroom-

Tips for Using Computers in the Lab

o Before entering the Lab, explain students’ task in detail
and give them any worksheets or reproducibles that they
will need during the lesson.

o If acomputer is not available in the classroom,
demonstrate the lesson on a computer in the lab before
allowing students to go to their individual computers.

o If thereis a computer in the classroom, demonstrate
assignments ahead of time using a scan converter that
connects your computer toa T.V.

o Have a predetermined silent signal that you can use to
quiet students quickly when you need to give directions.

o Develop a system that students can use to signal when
they need help. This may be as simple as placing a cup
upside down on top of the computer, or raising a flag that
is attached to the computer.

Tips for Using Computers in the Classroom

0 Make sure that students can easily see the computer or
monitor from where they are sitting.

o If using the computer as a learning center, introduce the
activity to the whole class at once and allow them to work
individually during center fime.

o Create a checklist to keep track of which students have
used the computer.

o Arrange the computers so that two chairs will fit in front
of each computer monitor.

0 Make sure that students have a place to complete pencil
and paper activities next to the computer or provide them
with lap desks.

Copyright © 2004 i3 Inc.
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o Using masking tape, create a box on the floor surrounding
the computers. Instruct students to stand outside the
box if they are not working on the computers. This will
prevent on-lookers from disrupting students who are
working to complete a task.

Other Helpful Management Tips
0 Make sure the technology is working the day of the lesson.
o Establish rules for asking questions and getting assistance.

See sample group o When working in groups, establish group leaders who can

leader cards that facilitate when you are busy.

follow. o Establish rules for using technology and post them near
the computer.

o Have a back-up plan in case the technology fails.

a Prepare an alternative plan for students who do not have
permission to use the Internet.

Teacher Talk - o Save students’ projects on the hard drive or a disk and

http://education.i print them later, when students are not in the room. This
ndiana.edu/cas/tt gives students more time to work.

/v1i2/what.html o Conserve ink by printing only projects and papers that will
Determine your be assessed. Do not allow students to print pictures they
classroom have made during their free time.

management style

and read a o  Turn down the volume on the computer or use headphones.
description of o Remind left-handed students to move the mouse and

your particular mouse pad to the left-hand side of the keyboard before
style. they begin.

o Have students collect all relevant data, write a rough
draft of essays, or prepare a storyboard for multimedia
presentations before coming to the computers.

o Post a copy of basic directions near the computer for
reference. These might include how to save to a disk, how
o print, how to open a program, or how to turn the
computer on and off.

o Have student helpers work with small groups, to assist
with ftroubleshooting and answering basic questions.

0 Make sure your lessons are appropriate for the ability
level of your students.

o Provide thorough instruction in technology skills needed to
complete the activity.
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o Give students worksheets, fact-gathering sheets, or
graphic organizers to help them organize information.

o Have a good working knowledge of how to use the
technology involved in the lesson.

o Encourage student learning through cooperative group

Teaching work, competitive teams, pair-share activities and other

Strategies teaching strategies.
http://www.discov

er.tased.edu.au/en L .
alish/strateqy.htm | The combination of a well-planned lesson and effective classroom

management will ensure that students will work productively to
complete the task assigned.
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Group Leader Cards

Disposable Tags: Print and copy onto sticker paper
Reusable Tags: Print onto construction paper, laminate, and string with yarn

Group Leader #

Got a question?
Ask me First!

Got a question?
Ask me First!

Got a question?
Ask me First!

“Software”
Expert

Got a question?
Ask me First!

Got a question?
Ask me First!

Font Expert

Got a question?
Ask me First!

Got a question?
Ask me First!
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Ask me First!
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Related
Resources

Utilizing Technology Centers in the Classroom

An in-depth look at
suggested lesson
plans and
management tips
for a centers’
approach to
teaching:
http://www.siec.k12
.in.us/~west/slides/
integrate/index.ht
ml

Sample rules poster
follows

Sample
Troubleshooting
Cards follow

Sample Rotating
Schedule follows

Using learning centers as a daily part of your routine is a
successful way to integrate technology into your instruction. In
a center, all students should be given equal time to complete a
task and various learning styles should be addressed. Ina
technology center, students will have the chance to explore and
extend the content being taught in other subject areas. There
are several keys to successful technology centers in your
classroom.

Organization

Assign a disk to each student at the beginning of the
school year that can be used to store assignments and
documents. This will alleviate the problem of excessive
documents being stored on the hard drive.

Post general rules for using the computer.

Make basic troubleshooting cards that can be laminated
and put in a box beside the computer. These instructions
can include information such as how to furn the computer
on and off, how to save to a disk, how to print, how to open
a program, how to adjust the volume, and other basic
operating instructions. Encourage students to use these
troubleshooting cards before asking you a question.
Create a rotating schedule to ensure that all students will
have the chance to participate.

Give students adequate time to prepare for their center
assignment before coming to the computer.

Give directions to the whole group before sending
students to the computers. If possible, post a list of
written directions near the computer for students'’
reference when completing their task.

Give students plenty of table space to do written work, or
provide them with lap desks.

a

Management
o Remind students to bring all necessary equipment to the
computer to complete their assignment.

Copyright © 2004 i3 Inc.
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Read more about
moveable
technology carts at
http://www.techlea
rning.com/db_area/

archives/WCE/arch
ives/hamilt2.htm

An on-line
dictionary can be
found at
www.merriam-
webster.com

Have a check-off sheet for students to use when they
have completed the task.

After students have completed their time on the
computer, ask them to record a few sentences in a class
journal, stating what they accomplished and what they
learned. This will keep students on-task and focused on
completing their project.

Computers can become mobile if placed on a rolling cart.
This enables you to move the technology to different
places throughout the room as you see fit (mobility will be
limited if you are working with the Internet).

Group more proficient students with those who need extra
help so they can serve as peer tutors and helpers.
Designate several student "computer experts” fo whom
students can go to ask questions if you are busy with other
students.

Language Arts Center Suggestions

Q

Type a list of spelling or vocabulary words using different
fonts and sizes in a word processing program.

Using KidPix, draw a scene that illustrates the main idea of
a paragraph and write a brief description.

Create an award to give to a hero from a fictional
literature selection.

Make a postcard from a character in a book that includes
details about the setting and events of a story.

Have students read a story from a Living Book CD and use
Inspiration webbing software to map out the story
elements (setting, characters, events, problem, solution).
Allow students to look up vocabulary words on an on-line
dictionary and type their definitions. You may choose to
have them illustrate several of these words in KidPix or
another drawing application.

Mathematics Center Suggestions

Q

Q

Do an activity involving probability by rolling the dice and
using a spreadsheet to chart the results. Compare
individual results and make a class graph.

Have students take a poll of their favorite foods and
graph the results in Graph Club or a spreadsheet.
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0O 0 0 O

Make an Inspiration web with the names of geometric
shapes and examples or attributes in the connecting
boxes.

Create a picture in KidPix using only geometric shapes.
Make a symmetrical picture in KidPix.

Illustrate a number sentence.

Create a pattern using stamps in KidPix or another drawing
program.

Social Studies/Science Center Suggestions

Q

Have students research a particular area of study on the
Internet and prepare a multimedia presentation using
KidPix or PowerPoint.

Ask students to interview a family member and create a
timeline of important events in their life using TimeLiner.
Students can create a map of their neighborhood using
Neighborhood Map Machine.

Using a drawing program, illustrate various landforms in a
scenic picture and label.

Use Inspiration to create a web showing a food chain.
Import graphics from the Internet to use with the web.
Create a database of animals and their characteristics
after researching the animals on the Internet.

Find e-mail pals from around the world and communicate
with them. Keep track of their home countries on a world
map.

Copyright © 2004 i3 Inc.
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Rules for Using the Computer

1. Keep food and drink away from the
computers.

Keep the mouse on the pad.

Treat the equipment with respect.
Follow directions carefully.

Ask your group leader or teacher if
you have questions.

Only print with permission from your
teacher.

ok wh

o
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Sample Student Rotation Schedule

This is an example of a scheduling chart for centers. Assign students to mixed

ability groups. Rotate the groups through different centers or stations

-13 -

throughout the week so each student is able to take a turn at the computer.

Blue Group VYellow Group Red Group Purple Group Green Group

Bob Austin Daryl Renee John
Dawn George Diane Latisha Jill
Kyle Mike Bill Jason Erin
Barbara Byron Pamela Gary Doreen
Manuel Joe Carol Juan Ahmed
Station/Center Monday Tuesday | Wednesday | Thursday Friday
Small Group with Red Purple Green Blue Yellow
Teacher
Computer Purple Blue Red Yellow Green
Media Blue Red Yellow Green Purple
Center/Research
Writing Green Yellow Blue Purple Red
Workshop
Math Center Yellow Green Purple Red Blue
Copyright © 2004 i3 Inc. inspiring, innovative, integration Appendix
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Troubleshooting Cards

Your toolbars have
disappeared in Microsoft
Word:

Click on View at the top and
Toolbars. Click on the
appropriate toolbar that you
wish to view. Click on it and
drag it to the top of your
screen.

Your computer has frozen up:

Instead of turning off the
switch on the CPU, do a
Soft/Warm Boot. Press

Control, Alt, and Delete at the
same time and your computer
will restart.

You can not access the
Internet or print from a
network printer:

Try restarting the computer
from the Start Menu.

You need to adjust the
volume:

Click on the speaker icon in the
lower right hand corner of the
bottom tool bar or click on the
Start button, Programs,
Accessories, Entertainment,
and Volume Control.

The Monitor is blank:

Check to make sure that the
monitor is turned on. You can
also check to make sure that
the cord to the monitor is
plugged in securely.

You can't find your document:

Click on the Start button,
Search, and For Files or
Folders. Type in the name of
your file and click Search Now.
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Related Assessing a Technology Infused Lesson
Resources
Evaluation is an essential part of the teaching-learning process.
Not only does evaluation allow you to see what students have
learned, but it also allows you to determine the effectiveness of
your teaching. Traditional forms of evaluation only assess
factual content and students’ progress in academic areas.
Because of the hands-on nature of technology, few traditional
assessments can accurately reflect the amount of creative and
critical thinking that goes into a technology-infused lesson.
Performance-based evaluations, such as those that follow, are
usually more effective.
Making the Choice
Assessing students’ progress should not be an isolated event.
Assessment should be incorporated into your lesson. Before you
decide on the best way to assess your project, consider the
following points:
o What do you want your students to know?
o How are you going to find out what they have learned?
o Who needs to know this information- teacher, students or
Rubric parents?
Generators: After considering these points, choose the assessment tool that
RubiStar - will most effectively evaluate your students’ learning.
http://rubistar.4t
eachers.org/
Teach-nology Rubrics
Rubric Generators | Because of the nature of technology infused lessons, rubrics are
http://www.teach- | very effective ways of determining if students have mastered
nology.com/web t | the skills. A rubric includes a set of criteria for evaluating
ools/rubrics/ . .
student products. There are several on-line rubric generators
that allow you to create and customize printable rubrics.
Project Based Learning Checklists
Learning Checklists can be used by teachers to evaluate students’ work or
Checklists . .
http.//4teachers. | 85 @ self- evaluation tool for students. When creating a
ora/projectbased/ | checklist, list the skills and outcomes that you expect students
checklist.shtml. to demonstrate. An easy way to create a checklist is to use an
on-line generator.
Ways to record

Copyright © 2004 i3 Inc.
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Observations:
http://www.templ
e.edu/CETP/templ
e_teach/a-
observ.html.

Graphic Organizer
Generators

http://www.teach-
nology.com/web_t
ools/graphic_org/

Using Concepts
Webs for
assessment:
http://www.templ
e.edu/CETP/templ
e_teach/a-

concpt.html.

Electronic
portfolios:
http://www.ash.ud
el.edu/ash/teache
r/portfolio.html

Teacher Observation

Anecdotal records and behavior checklists are excellent ways to
use teacher observation as an assessment tool. To evaluate
students with a checklist, you need to create a chart that
includes the tasks and behaviors that you expect of students and
evaluate them while they work. If you are assessing students on
a series of basic technology skills, you can create a checklist and
note as they accomplish each item on the list. Anecdotal records
are written comments about a student’s behavior and academic
progress.

Concept Webs

A Concept Web is a diagram that demonstrates a relationship
between concepts or ideas. A concept web helps students
organize information and make connections between the
information that they have learned. Inspiration software is an
excellent way for students to complete this form of assessment
on the computer. If this software is not available at your school,
try an on-line Graphic Organizer generator to create webs that
you can print.

Portfolios

Student portfolios are collections of student work. Portfolios
can include essays, artwork, reports, digital photographs, graphs,
charts, audiotapes, multimedia presentations, etc. They can be
printed and stored in a folder or they can be electronically
stored on a disk. Portfolios can be easily transferred to VHS
tapes to share with parents who do not have computers at home.

Audlio and Video Tapes

Audio and video recordings give teachers the chance to create an
academic and social growth record throughout the year.
Videotape students as they interact in groups, class plays, work
in centers, and on other special occasions such as field trips.
Audiotapes can be a great way of keeping track of students’
progress in reading expression and fluency from the first of the
year to the last.

Journals
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When doing lengthy research-based projects, students can be
evaluated on their progress using journals. Have students keep a
written record of what they know about the fopic before the
Sample peer research begins, what they learn about the subject as they work,
evaluation forms: | and what they have learned as a result of the project. In their
http://www.potsda | journal, they can share with you what technology experiences
m.edu/educ/6LC/i | wepe useful and which were not as successful. Journals are not
Ke/grouphiml usually evaluated for accuracy, but are a very useful tool for

http://www.ncsu.e ) }
du/midlink/rub.mm | Students to reflect on their own work on a project.

proj.htm

Peer Evaluations

When working on group projects, students can be given the
opportunity to evaluate their groups' effectiveness. This can
motivate students who are reluctant to participate and gives
students who may do the majority of the work opportunity to
share that fact with the teacher.

Self Evaluations

Students should occasionally be given opportunity to evaluate
their own work and reflect on their effort and performance. In
a self-assessment, students should be able to rate their
performance, explain reasons for choosing the processes they
used, and identify any changes or improvements that they could
make to their project.
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Related
Resources

Reaching Students through
Cooperative Learning

Jigsaw Classroom
http://www.jigsaw
.org/ - information
about how to use
the Jigsaw
technique in your
classroom

GLC Eisenhower
Project

Students receive many academic and social benefits from
cooperative learning activities. As they collaborate with their
peers, students gain a deeper understanding of the content,
think more creatively, take leadership in completing tasks, and
learn group responsibility.

Cooperative Learning Strategies

Jigsaw
Using the jigsaw technique, each student has the task of learning
one part of the lesson and then "teaching” it to the rest of the
group. Tasks can be individualized so that some group members
can be provided with more challenging materials to read than less
skilled classmates. The most important thing is that the entire
group benefits from the efforts of each individual. Steps in the
jigsaw process include:

1. Divide students into heterogeneous jigsaw groups of 5 or 6
students.
Appoint one student from each group as the leader.
Divide the day's lesson into 5-6 segments.
Assign each student to learn one segment.
Form “expert groups” by having one student from each
jigsaw group join other students who are studying the
same lesson segment. Give the expert groups time to
discuss the main points.
Bring students back together with their jigsaw groups.
Ask each student to present his/her segment to the group.
Add some form of assessment at the end to evaluate
students on each segment of the lesson to make sure that
they mastered all subject matter.

oOrwn

® N

Standards Teams Achievement Division (STAD)

STAD is a simple way to introduce cooperative learning to your
students and a great starting place for teachers who are new to
cooperative learning. STAD has five components: class
presentations, teams, quizzes, individual improvement scores, and
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http://www.potsda
m.edu/educ/GLC/i
ke/stad.html-
Instructions on
how to prepare
and carry out a
STAD lesson.

GLC Eisenhower

Project

team recognition. Steps ina STAD lesson:

1. The process begins with the teacher or an audiovisual
presentation introducing the subject matter to the whole
group through direct instruction.

2. Then students are divided heterogeneously into groups of
four or five students. Teams meet to study worksheets
and material to prepare each other for the quizzes that
follow.

3. Each student is given a quiz individually, and is therefore
held responsible for their individual learning.

4. Students are given individual improvement scores, which
are performance goals that the student can reach.
Students earn points for their team based on their
improvement over their past scores.

5. The final stage is team recognition. Teams can earn
certificates or other awards if their average scores
exceed a certain criterion.

Think-Pair-Share

This cooperative strategy allows students to think about a
question or idea and share their thoughts with a partner before
discussing the concept as a class. In a partner arrangement,
students are free to share their thoughts and have their ideas
are validated by a peer. This method also enables students to
express their thoughts and ideas to class members outside their
peer group. The steps in this process are:

1. Identify the question or concept to be discussed.

2. Allow students time to think individually.

3. Pair students and have them share ideas.

4. Have pairs communicate their ideas to the whole

group and record all ideas.
5. Use the list of ideas for future work or research.

Peer Tutoring

This technique turns students into teachers and provides great
benefits to both the futor and the learner. Peer tutoring
involves a peer “expert” instructing a "novice" in a particular
subject or skill. Peer tutoring is successful because children
often speak the same "language” and know how to communicate
with each other more effectively than adults. The tutor learns

Copyright © 2004 i3 Inc.
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http://www.potsda
m.edu/educ/GLC/i
ke/think.html - A
sample lesson on
that uses Think-
Pair-Share

Cross-Age and
Peer Tutoring
http://www.indian
a.edu/~eric_rec/i
eo/digests/d78.ht
ml - Contains
detailed
instructions on
how to start a
peer-tutoring
program in your
school.

Explanations of
group roles:
http://www.potsda
m.edu/educ/GLC/i
ke/role.html

See the Group
Role Badges that
follow

how to effectively communicate with peers while the content or
skill that they are teaching is reinforced in their own mind. The
learner gains content knowledge, as well as individual attention.

Assigning Roles

Within cooperative groups, students are often assigned special
roles. This holds students accountable for specific content and
helps them feel a sense of ownership in the final project.

Dividing Students into Heterogeneous Groups

Heterogeneous grouping enables all students to get the most out
of cooperative learning. Cooperative groups should include
students from varying ability levels, genders, and ethnic
backgrounds. There are many ways to divide students into
groups. Here are a few examples:

1. Have students number of f.

2. Divide students into feams based on the colors that they
are wearing.

3. Have students draw slips of paper with group numbers
written on them.

4. Group students whose last names begin with the same
letter of the alphabet.

5. Create picture puzzles and distribute them to students.
Those students whose pieces complete the same puzzle
make up a group.

6. Print sentences or phrases on strips of paper and pin one
to each student’s back. Students must find their group
members by asking questions of their classmates.

7. Pass out candy and have students form groups based on
the type of candy they received.
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Group Role Badges

Print and copy these badges onto sticker paper.

Summarizer Checker of Accuracy
Understanding Coach
Elaborator Research Recorder
Runner
Encourager Observer Time-Keeper
Praiser Harmony Noise
Coach Monitor
Energizer Reporter Encourager of
Participation
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Related
Resources

Planning a Technology Infused Lesson

Three Components
of Effective
Computer Use:
http://www.essdac
k.org/tool/compon
ents.html

Several years ago, a few teachers began integrating technology
into their classroom with a Macintosh ITe computer in the back
of the room. This computer often served as a center for drill
and practice games, which at the time, was very high-tech. But
with the computer revolution, computers have moved from the
back of the room to the forefront of education and have become
an exciting and engaging tool for both educators and students.
Here are points to keep in mind when planning a technology
infused lesson.

Content

The easiest way to begin using technology with your students is
Yo integrate it into your tried and true lesson plans. Use plans
that you have taught before and know are successful on their
own merits, regardless of the technology component. This way,
if the technology fails, you will have another plan on which to
rely. Consider plans that involve:

Research on a particular topic

Comparing and contrasting information

A multicultural or country study

Researching and writing a report

Using graphics and art

Collecting and analyzing data

Making a presentation

O 0000 0o

Once you become more comfortable with technology, you will be
able to create technology infused lessons based on a particular
piece of technology or software and be more confident about
each lesson.

Technology
There are three effective ways to use computers in your
classroom:
o Teaching Content: Students gain knowledge in content
area subjects.
o Enhancing Critical Thinking: Students are engaged in
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See examples of
how to integrate
the Internet into
your curriculum at
Tech Learning
http://www.techle
arning.com/db_are
a/archives/WCE/a
rchives/kenroy.ht
m

Determine your
students’ learning
styles:
http://www.mxctc.

commnet.edu/clc/
survey.htm

See the list of
teaching
strategies at
Discover
http://www.discov
er.tased.edu.au/en
glish/strategy.htm
for more
suggestions.

higher level thinking while using the computer.
o Teaching Computer Skills: Students can gain technical
skills while working at the computer.

Each of these three components can be incorporated separately
or together to create a lesson that uses technology on a number
of different levels.
When deciding what technology to use, think of ways that you
can use it o enhance and extend the content that you are
teaching.
o Would students benefit from an on-line field trip?
a Can students organize their data in the form of a graph or
chart on a spreadsheet?
o Can students create a multimedia presentation to share
their knowledge of a content area?
o Can students illustrate a concept using a drawing program?

Method
Just like other lessons that you teach in your classroom, you
must determine the way in which the lesson will be tfaught and
what role you will play in the instruction. When determining this,
consider your students' learning styles and make sure that you
address all those learning styles within the lesson. A few
methods to consider are:

o Whole group or small group
Cooperative grouping or independent work
Pair/share activity
Each one, teach one
Jigsaw technique

0O 0 0 O

You must also decide what your role will be in instruction.
Determine whether you will serve as instructor by demonstrating
a piece of software to a whole group or be a facilitator to
students as they work individually or in small groups.

Assessment

After determining what you will feach and how you will teach it,
you need to think about how students will be evaluated.
Assessment serves two purposes: to inform you of how well
students are mastering the concept being taught, and to let you
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Authentic
Assessment:
Performance
Tasks and
Rubrics-
http://www.skylig
htedu.com/neighb
or/articles/article
002.html

For more
information about
each type of
assessment tool,
go to Assessment
Strategies and
Definitions
(http://www.rmcd
enver.com/usequid
e/assessme/defini
ti.htm

evaluate the effectiveness of your instruction. Traditionally,
students are assessed on knowledge level questions using paper
and pencil tests. Because technology infused lessons often
involve higher level thinking, students should be evaluated on
several different levels.
Technology-infused lessons are more effectively evaluated using
performance-based assessments. Rubrics checklists are
excellent forms of assessment for evaluating this type of lesson.
Some other possibilities include:

Electronic Portfolios

Student Portfolios

Journals

Conferences

Discussions

Attitude Surveys

Peer and Self-Evaluations

Prior Knowledge

After deciding what to teach and how to teach it, you need to
consider the prior knowledge that your students will need in
order to be successful at their task. If you are planning a lesson
using the Internet, be sure to do an introductory lesson
demonstrating how to use the Internet. In most cases, it is
beneficial o spend one class period introducing the technology
or software before teaching your lesson. Then students will be
comfortable with the technology and the focus will be on the
lesson, and not on how to use the technology.

Location
Depending on the technology available at your school, you may
have several locations where you can teach your lesson.
o Whole Group lesson with one computer and a scan
converter
o Small group lesson centered around one computer
o Computer lab situation with students working
individually or in pairs
o Center activity with one or two students working
independently

Appendix
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On-line access to
Technology
infused lesson
plans:

EdHelper.com-
http://www.edhelp
er.com/

Teaching 'N
Technology-
http://twister.coe
du.usf.edu/tnt/

Computer Lesson
Plans-
http://www.missis
sippi.net/~lamarel
m/technolo.htm

Tech Lessons-
http://www.bonny
doon.santacruz.k12

.ca.us/apple_core/
techless/techless.
html

Materials

Once you have finalized your lesson and determined the
equipment you need, check to make sure that everything is
working and that you are familiar with the operation of the
equipment. If working with a specific web site on the Internet,
check the link at the beginning of the day to be sure that it is
working. Because of the changing nature of the Internet, web
sites can experience difficulty for a few hours and be out of
operation during that time.

You also need to check on the availability of the equipment. If
you are depending on a digital camera, make sure that it is
available for check out on the day that you need it.

Planning a technology-infused lesson takes organization and
preparation, but students’ learning will be enriched and they will
gain valuable critical thinking skills. Here are several sites that
feature technology infused lessons to help get you started.
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Conclusion

When using computers is hew to students:

Begin slowly and watch how many steps you are asking them to complete.
Allow time for exploration and the sharing of discoveries.

Make sure directions are clear.

Make sure the activity will allow students to practice a skill or concept that
fits. with the instructional goals in the classroom.

Ensure that all students get the opportunity to do the activity.

Realize that young children use computers differently than adults.

using computers and other technology is new to you:

Begin slowly- flashy projects that take forever to complete may not be the
best use of the resources you have.

Integrate one new piece of software or technology skill at a time.

Test the directions of any assignments you create.

Plan for technology usage like you do for any other teaching resource.
Establish goals for what you want your students to do with technology that
fit with your educational goals.

Choose grouping options that best fit the instruction.

Work with administrators and parents to choose the resources that will best
suite the needs of your students- that includes software, peripherals such
as scan. converters or digital cameras, or fee- based Internet content.
Take advantage of technology literate parents to assist students at planned
times.

Establish with students what they do if they are having trouble.

Try- once you begin your students will astound you with what they can do!

Appendix inspiring, innovative, integration Copyright © 2004 i3 Inc.



Curriculum & Technology Integration Training -27 -

Setting up a Eudora E-mail Account

Getting Started:
> Open up your Internet browser.

> Click in the Location Box to highlight the URL.
> Type: www.eudoramail.com
> Press Enter on the keyboard.
> Click on Sign-Up for your own free personalized E-
mail!
» This will take you to Eudora Web Mail Terms of Use.
> After reading (or not) the Terms of Use, click on "I Accept”.

Setting Up an E-Mail Account:

> Click in the box by User Name to place the cursor.
Type your first initial and last name (example: tsmith).
Press the Tab key to move to the next field.
Choose a password and type it in the Choose a Password box.
Press tab to get to the next field.
Type in the password again in this box.
Choose your time zone from the pull down menu.
Choose a password hint from the next pull down menu.
Click in the box below and type the answer to the question.
Press Tab.
Enter the necessary information in step 2.
All fields with a red dot are required fields and must be answered.
After completing all required fields, click on Register.

VVVVVVVYYYYYVYYVY

Completing the E-Mail Setup Procedure:
> Your assigned E-mail address will appear on the screen.
> Type in your password and hit Enter.
> This will take you to the Eudora Web-mail screen.
> You will now be at the In-Box where you will receive your mail.

Receiving and Sending E-Mail:
> If you have new mail, it will be listed in the In-Box.
> Click on the highlighted blue text to open your e-mail.
> To send an e-mail, click on the New Message button at the top of your
screen.
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Type in the Address of the person to whom you will send the message and
press the Tab key.

Type in a Subject for the e-mail. Example: "Technology Training".

Click in the message box to place the cursor and start typing.

Do a Spell Check with the button at the bottom of the screen (scroll
down).

After you have completed your e-mail message, click on Send.

You will receive a confirmation message.

Click on Inbox mailbox to return to the main screen.

CC: Stands for Carbon Copy- if you wish to send e-mail fo several different
people, list them in the CC section. The other recipients will see a list of the
people who received the message.

BCC: Stands for Blind Carbon Copy- If you wish to send e-mail to several
different people, but prefer that they do not know who else received the e-
mail, list them in the BCC section. The recipients will not see a list of the
other people who received the message.

Attachments: You can send a file along with your e-mail message. Simply
click on Attach File in your new e-mail message. Click Browse to locate the
file and then click attach.

Replying to a Message: If you would like to reply o a message sent to you, click
on the reply button at the top and type your message. A reply goes back to the

sender.

Forwarding a Message: If you would like to forward a message to someone else,
click the forward button at the top. Forwarding a message just sends that same
message that you received to a different person.

Accessing Eudora Mail after registration:

>
>

>
>

Appendix

Type in www.eudoramail.com in the location box of your Internet browser.
In the Registered Users box, under username, type your e-mail
name.(example: tsmith).

Type in your password. Press the Enter key.

You will be taken to the main screen where you can send and receive e-
mail.
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Classroom E-Mail Activities

E-mail has opened up a whole new world of communication that links adults and
children internationally. Because e-mail has become
such an integral part of communication, it is important
that students be given the opportunity to share ideas
and thoughts with their neighbors around the world.
Here are some suggestions for using e-mail in your
classroom:

o Find an e-pal from another state or country and
exchange information about cultural
differences. Locate e-pals on
http://www.keypals.com/ or
http://www.epals.com/.

o Send weekly e-mail messages to all students that include your weekly
schedule, reminders, homework assignments, and special project information.

o Allow students to e-mail writing projects to each other for peer editing.
The editor can make changes in red type and return the document to the
author.

o Students can share writing, thoughts, or technology projects with parents
and guardians by attaching them to an e-mail message.

o E-mail experts to ask questions students formulate about content area
subjects and units of study.

Participate in on-line collaborative projects with other schools.
Communicate with congressional leaders in Washington at
http://www.mrsmith.com/index2.html.

o Ask students to write fan mail to their favorite athlete or sports team. You
can locate e-mail addresses for most sports teams and athletes on their
homepages.

o Send e-mail fo Santa at http://www.north-pole.net/.
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Whole Group Learning with your PC

The Scan Converter
The easiest and cheapest way to accomplish whole group learning in your classroom
with a PC is by hooking up a scan converter. Scan converters are small devices that
translate the scan rate so the image on your computer screen can be seen on your
TV. Now this may sound simple, and it is, but the final quality depends on several
factors. If you have a new(er) TV and new(er) PC you should be in pretty good
shape. Older TV's/PC's will require a bit more work and the quality will be lower.

It is impossible to address P
the myriad ?f pos§|ble =r=dl
set-up configurations, so [
below you will find drawing |

. [
of a basic set-up. Do your Back of F (Coxial
best to follow these or PoonBAE | s
consult the Web voh o

resources or your
technology professional in 5.~
your school or district. Qutlet

RF (Coaxial-Out to T)
—

VCR or
RF Modulator

[ —

1 _ﬂ_f,_df#ff’/mﬂ

Sean (Video
Converten DRCP. RCA Cable In)

(Widea)

WVigA In WA Cut

Web Resources:
10 Questions to ask
before buying a scan converter. http://www.vgav.com.au/convertors.htm

The Data Projector
This piece of hardware is quickly becoming the choice of educators for whole group
instruction in their classroom. The data projector is the equivalent of the movie
projector except instead of film being projected on the wall it projects what's on
your computer. These use o be so expensive that districts were lucky to have just
one. Recently manufactures have broken the $1000 floor on some models. Now it is
not uncommon to see new schools being built with these built-in to all classrooms.
Even though these can be purchased for under $1000 plan to spend about $1200-
$1600 for one of these for your classroom.

Web Resources:
http://www.becta.org.uk/teaching/pedagoqgy/technologies/projectors.himl
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Software
Helpers
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Software Helper
Windows Basics

The first screen that you see after starting your computer is called the Desktop.
It is where you do all of your work. There are certain items on your desktop that
are there to facilitate your work. These items can be customized to meet your
own needs.

Items on the Desktop:

o My Computer- This icon enables you to have access to your hard, floppy, and CD
drives. You can also access your printers and the control panel.

o Network Neighborhood- Provides access to shared resources, such as printers
and networked computers.

o Recycle Bin- A temporary holding bin for files that you want to delete. Files
placed in the recycle bin can still be recovered until they are permanently
deleted.

o Start Button- Provides access to the Start Menu. From the start menu, you
can access programs, documents, settings, help, and search options.

o Taskbar- This is the horizontal bar located at the bottom of your Desktop. All
of your open applications are shown on the taskbar and it enables you to move
easily between applications. The taskbar also displays the clock, the Start
button, and may house some shortcuts fo programs.

Turning the Computer On and Off

To turn the computer on, check to see how the computer is plugged into the
electrical outlet. If the CPU, monitor, speakers, and printer are all plugged into a
power strip, simply turn on the power strip. If each part is plugged into a
different outlet, turn on the monitor first, then the CPU and finally the speakers
and the printer.

To turn the computer off:
Close all programs, windows, and folders
Click on Start, and then Shut Down
Click on Yes.
Wait until the computer gives you the message that it is safe to turn off the
computer.
Then either turn off the power strip, or unplug the parts in this order:
monitor, CPU, speakers, printer.
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Executing a Program

>
>

>

Click on Start and drag the arrow to Programs.

Draw the pointer to the folder where the program resides and to the
name of the program.

Click to start the program.

Installing a Program

Most CDs will automatically open up in the Install Mode. You will simply follow
the on-screen instructions. If it does not, follow these steps:

>

YV V VYV V

Y

Click on Start.

Drag the pointer to Settings, then click on Control Panel.
Double-click on Add/Remove Programs.

Click on Install.

Insert the CD or Disk into the drive.

Click on Next.

Follow the on-screen directions.

To Create a Folder on the Desktop:

Y
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Right click anywhere on the blank desktop.

Click on New and then on Folder.

Type in the name for the folder. (Example: name it "Applications”)
Press Enter

A folder entitled "Applications” should appear on the desktop.

To Create a Shortcut to a Program:
A quick and easy way to access programs is by making a shortcut on the desktop or
in your applications folder.

>

YV V V VY
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Double click on the Applications folder to open it.

Click on File, then New.

Click on Shortcut.

Click on Browse (you may need fo change the drive to “C")

Find the program for which you want to make a shortcut (for example
KidPix Studio)

Look for the file name that has .exe at the end (Picker.exe)

Click on Picker.exe and then Open.

Click on Next and type a name for the shortcut. (KidPix Studio)

Click on Finish.

Find your new shortcut and test it out by double clicking on it to open the
program. Close the program by clicking on File and Quit.
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To Format a Disk:
Most new blank disks will not need to be formatted. In the case that it does:

To Co

VVVVVE VYYYVYVYY
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Double-click on My Computer.

Insert a floppy disk into the "A" drive.

Right click on the "A" drive icon.

Click on Format, under Format Type, click on Full.

Click on Start.

Click on Close.

Close the My Computer window.

a Disk:

Double-click on My Computer.

Insert the disk you want to copy into the "A" drive.

Right click on the "A" drive.

Click on Copy Disk and then Start.

When the message "Insert the Destination Disk”, put the blank disk to
want to copy to into the "A" drive.

Click on OK.

Click on Close when you get the message, "Copy Completed Successfully.”
Close the My Computer window.

To Create a System (Start Up) Disk:

>
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Double-click on My Computer, then on Control Panel.
Double click on Add/Remove Programs.

Click on the Start Up Disk tab.

Click on Create Disk.

Insert a disk into the A drive.

Click on OK, then OK again.

Click on the X in the title bar to close the Control Panel
Close the My Computer window.

To Rename a Folder or File:

Y
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Double-click on My Computer.

Double click on the drive that contains the folder or file to be renamed.
Click on the file you want to rename and then click again (softly).

This will highlight the old name and a cursor will appear.

Type in a hew hame.

Press Enter.

Close the My Computer window.
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Deleting a File or Folder

>
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A\

Double click on My Computer and the drive in which the folder is located.
Click once on the item you wish to delete and highlight it.

Press Delete on the Keyboard.

It will go to the Recycle Bin, you can retfrieve it until you permanently
delete it.

To retrieve the item, double click on the Recycle Bin, and click on the
folder you wish to restore. Click on File, and then Restore. It will return
Yo its original location.

Moving a Window

>

In an open window, click on the Title Bar and drag the window to the
desired location.

Resizing a Window

>

Put the pointer on the lower right corner of the window ( you will see a
diagonal arrow). Click and drag to make the window smaller or larger.

Copying and Moving Files

>
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Double click on My Computer and then on the drive where the file is
located.

Double click on the drive where the file is to be moved or copied.

Move the open windows so you can see both of them clearly.

Find the file you want to copy and click on it.

If you are copying a file, click and drag the file to the appropriate drive.
You will now be able to access the file in both places.

If you are moving a file, hold down the Shift key as you drag and drop
the file.

Playing an Audio CD

YV YV VY VYV

Open the CD ROM drive by pressing the button.
Insert your CD.

Press the button again to close the door.

The €D should begin playing automatically.

The CD player will be shown on the taskbar.
Click on the CD player to open the window.
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> Place the arrow on the various buttons in the CD player to see the
different options.

> The "Stop” button is the black square, the "Play” button is the black
triangle.

> Click on the "Minimize" button (-) to place the CD Player back on the
Taskbar.

> Click on the "Close” button (X) to exit the CD Player. (Be sure to stop the
CD before you exit.)

Volume and Sound Controls

There are two places to adjust the volume:
Check to make sure that the speakers are turned on and plugged in.

> Click on the speaker icon in the lower right hand corner of the
Taskbar.

> Move the lever up or down to adjust the volume accordingly.

> Click on Start, drag to Programs, Accessories, Multimedia, Volume
Control, and click. Adjust the volume in the same way.

Changing the Desktop Wallpaper (Background):
> Right click anywhere on the blank desktop.
Click on Properties.
Click on the Background tab if it does not come up automatically.
Under Display, click on Tile.
Under Wallpaper, click on the various patterns you can use on your
desktop. Select one that you like and click on it.
> Click on Apply and then OK.

YV V V VY

Changing the Screen Saver:
> Right click anywhere on the blank desktop.
Click on Properties.
Click on the Screen Saver tab.
Click on the down arrow to see a list.
Click on the various screen savers, find one that you like and select it.
Click on Preview.
Click on the screen to return to the Properties window.
Choose how long you want your computer to be idle before the screen
saver comes on. Choose 1 minute in the Wait option.
Click on OK.

YV VYV VY VYV

Y
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To Change the Number of Colors that the screen uses:
If your computer should give you a message stating that the program you are
trying to run only runs in 256 colors, follow the directions below.

> Right click anywhere on the blank desktop.

> Click on Properties, then on Settings.

» Under Color Palette, select 256 colors and in the desktop area, the
setting should be 640x480 Pixels.

> Click on OK.

Copyright © 2004 i3 Inc. inspiring, innovative, integration Appendix



Curriculum & Technology Integration Training -38 -

Software Helper
Windows 95

How Do I:
Clear items from the Documents menu:
> Click Start, Settings, Taskbar, Start Menu Programs, Clear
> Or right click on the Taskbar, Properties, Start Menu Programs, Clear

Bring up the Taskbar:
> Press Control + Escape on the keyboard

Create a new folder on the Desktop:
> Right click on the Desktop, then click New Folder

Open Programs:
> Click on Start, then Programs

Switch from one program to the next:
> Click on the name of the program on the Taskbar

Close a window:
> Click on the X in the window or...
> Press Alt + F4 on the keyboard

Close all the windows in sequence:
> Press the shift key and click on the X

Minimize all windows at once:
> Right click on an empty spot on the Taskbar, and click Minimize all
Windows.

Quickly Maximize and restore a window:
> Double click on the title bar of the window

Tile Windows:
> Right click on an empty spot on the Taskbar, click on Tile Horizontally or
Vertically

Appendix inspiring, innovative, integration Copyright © 2004 i3 Inc.



Curriculum & Technology Integration Training -39 -

Keep Multiple windows from opening:
> Double-click on My Computer, then View, Options, Folder, and Browse
folders by using a single window.

Move to a Previous Window:
> Hit the backspace key on the keyboard.

Change the Window Display:
» Click on View, then choose Large Icons, Small Icons, List or Details.

Move icons on the Desktop then they seem to be "locked":
> Right click on the Desktop, then Arrange Icons. Take the check mark off
of Auto Arrange.

View File Extensions:
> Click View, then Options. Take the check mark off of Hide MS-DOS
extensions.

Customize Taskbar options:
> Click on Start, Settings, Taskbar, then Taskbar Options

Move the Taskbar:
> Click on the Taskbar and drag it to a new location.

Resize the Taskbar:
> Drag on the edge of the bar.
Shut Down the Computer:
> Click on Start, Shut Down, then Yes

Warm boot the Computer:
» Click on Start, Shut Down, and Restart the computer.

Start the Computer in DOS mode:
» Click on Start, Shut Down, and then Restart the computer in MS-DOS
mode

Log on as a different user:

> Click on Start, Shut Down, and then Close all programs and log on as a
different user.
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Restart the Computer in Safe Mode:
> Press F8 on the Keyboard.

Get Windows Help:
> Click on Start, then Help.

Find a File:
> Click on Start, Find and choose Files or Folders.

Save a file in a folder on the Desktop:
> Click on File, Save As, then Desktop. Double click on the appropriate
folder.

Open a file in a folder:
> Double-click on it

Choose a program in which to open a file:
> Press the Shift key on the keyboard, right click on the file and choose
Open with...
Insert a Special Character:
> Click on Start, Programs, Accessories, Character Map, Wingdings, Pick a
Character, Select, and close the window.
> Click on Edit, Paste (You need to have the insertion point at the place
where you want the character to appear. You also need to change to
Wingdings in the application)

Set a Default Printer:
> Click on Start, Settings and Printers. Right click on the printer and set
as Default.

Install a Printer:
» Click on Start, Settings, and Printer. Double-click on Add Printer.

View the Clipboard:
> Click on Start, Programs, Accessories and Clipboard Viewer.

Change the Date or Time:

> Double-click on the clock on the Taskbar, and make the needed changes.
Close the window.
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Change the Wallpaper:
> Right click on the Desktop, Properties, Background Tab, and Wallpaper
or...
> Click on Start, Settings, Control Panel, Background Tab and Wallpaper.

Change the Background Color of the text on the Desktop:
> Right click on the Desktop, Properties, Appearance, Item-Desktop
> Choose the Color then click Apply and OK.

Change the Screen Saver:

> Right Click on the Desktop, Properties and Screen Saver Tab or...
> Click on Start, Control Panel, Display and Screen Saver Tab.

Change the Font of the text on the Desktop:
> Right click on the Desktop, Properties, Appearance and Item-Icon or..
> Click on Start, Settings, Control Panel, Display, Appearance and Item-
Icon.

Change Mouse Settings:
> Click on Start, Settings, Control Panel, and Mouse

Add items to the Start menu:
» Click on Start, Settings, Taskbar, Start Menu Programs, and Add...

Remove items from the Start menu:
» Click on Start, Settings, Taskbar, Start Menu Programs, and Remove...

Install a Software Program:
» Click on Start, Settings, Control Panel, Add/Remove Programs, and
Install.

Create a shortcut to a software program on the Desktop:
> Right click on the Desktop, click on New, Shortcut and Browse.

Install a Font:
> Click on Start, Settings, Control Panel, Fonts, File, and Install New Font.
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Software Helper
Windows 98

Windows 98 is easier to use and more user-friendly. It features icon highlighting,
forward and backward buttons, an auto-complete feature and easy to customize
Start menu.

4 New Toolbars:
» Quick Launch Pad- Allow easier access to your favorite programs
> Address- Enables you to type in a web address from the toolbar
> Links- A selection of one-click connections to commonly used Web sites.
> Desktop- Enables you to put your entire set of desktop icons on the
toolbar.

Start a Program using the Quick Launch Pad:
» Click on an icon on the Quick Launch Pad located at the bottom left of
the screen.

Return to the Desktop using the Launch Pad:
> Click on the Desktop icon on the Launch Pad

Add a Program to the Launch Pad:
> Click on Start, Programs and locate the program you wish to add.
» Right-click and drag the icon to the Launch Pad.
> Release and click on Create Shortcut Here.

Change the Length of the Launch Pad:
> Click and drag the line located to the right of the Launch Pad.

Delete an icon from the Quick Launch Pad:
> Right click on the icon and select Delefte.

Address Bar (allows you to type an address from the toolbar):
> Right click on the taskbar, click on toolbars and address.
> Click inside the address box and type in your URL

Links Toolbar:
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» Right-click on the taskbar, Toolbars and Links
> Click on a link and your web browser will launch the site.

Widen the Taskbar:
> Click and drag the top of the taskbar to make additional room for the
toolbars.

Delete a link from the Links Toolbar:
> Right-click on a link and select Delete

Add a link to the Links Toolbar:
> Open your web browser and locate a favorite page.
> Click and drag the location icon to the left of the address onto the
beginning of the links toolbar.

Desktop Toolbar:
> Right-click on the taskbar, click on Toolbars and Desktop

Forward and Back Buttons:
> Click on My Computer and Drive C.
> Click on the Windows Folder and then Show Files.
> Click on the Back and Forward Buttons.
> Click on the drop-down arrow on the Back/Forward button.

Change the Background of a Folder:
> Double-click on a folder.
> Click on View and Customize this folder.
> Choose a background picture and click Next
> Select a background picture, click Next and Finish.

Undo Customization:
> Click on View, and Customize this folder
> Click Remove Customization.

To make a graphic from the web your wallpaper:
> Open your Internet browser.
> Locate the graphic you wish to use and right-click on it.
> Choose Set as Wallpaper.
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To return the wallpaper back to its original state:

>
>
>

Right-click on the desktop and click on Properties.
Click on the Background Tab and select the option you wish.
Click OK.

To change the Background Themes:

>

What is
>

Click on Start, Settings, Control Panel and Desktop Themes

the Active Desktop?

One of the improvements in Windows 98 is the Active Desktop, which
enables the Windows desktop to interface with the Web. This feature
enables you to navigate by clicking on links rather than double-clicking
icons. You can also use the Active Desktop as an information center, by
placing components from the Web on your Desktop to display news,
weather, sports and other important information.

How do I turn on the Active Desktop?

>
>
>
>

What is

Click on Start, Settings, Folder Options, Web Style, and OK or...
Click on Start, Settings, Active Desktop, View as Web Page

The cursor now furns into a hand when you move over icons.

The channel bar is an indication that the Active Desktop is furned on.

a Channel?

A "Channel" is a web site that is designed to deliver information from the
Internet to your computer, similar to subscribing to a Web site. A
subscription enables your computer to download updates on a regular
basis for you to view at your convenience, without paying connection
charges. You don't have to subscribe to view the content on a channel,
but you may want to set a schedule for your subscription. Another
advantage of channels is that you don't just see the Web page, you see a
map of the Web site that enables you to quickly select the information
you want.

How do Channels Work?

>

>

Appendix

Use the Channel Guide on your desktop or in your internet browser to see
a list of channels available through the Microsoft Web site. This list is
frequently updated with the latest offerings.

Add channels to your Channel bar. If you wish, you can subscribe to a
channel when you add it to your Channel bar however, you don't have to
subscribe to a channel fo view it.
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Add channels to your Channel Bar:
> Click on Channel Bar and Active Desktop items.

> Click on a channel of your choice and Add Active Channel.

> Click NO, just add it fo my Channel Bar-.

To Delete a Channel:
> Right-click on the channel and click Delete.
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Software Helper
Introducing XP Things You Might Like to Know

Microsoft Office XP software is full of features and options. Although many of
the features have been in the MS Office software for a while there is some new
functionality in this version.

Task Pane

Task Pane is a new feature in Microsoft XP
Software. It puts key commands in a panel
on the right side of the computer screen. I't
is specific to the software that you are

. . . Open a document
using so the PowerPoint Task Pane is PowerPoint Z000- T
different from the Word Task Pane PowwerPoint 2000- T
although there is some overlap. One hice PEREIED o

. . . Excel 2000- Making
thing about Task Pane is that it makes e ——
visible some options that people might not

< MNew Docur > X

Mewr
otherwise find, like TemplaTes. [ Blank Docurment
@ Blank. web Page
® Left and right arrows in the tan bar at B Blank E-mail Messag
the top of the Task Pane window let's Dew from existing
ocumenkt
you switch to other lists of commands. #57] choose document.,
Mew from template
#® The dl"Op down arrow in the tan box at | ] General Templakes,
the top of the task pane let's you see a 2] Templates on my W
list of menus that are available. & ] Templates on Micro:

#® The X button in the tan box let's you
close the task pane and gives you a
larger screen space.

k. 3

To prevent Task Pane from opening when

you start a program, click on the View % Add Metwork Place.
menu and remove the check next to Task [Z] Microsoft Wword Help
Pane. Another option is to remove the v| Show at startup i’

check next to Show at Startup at the
bottom of the New Document Task Pane
window.
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Start Button

In XP the interface under the Start button has been redesigned. Things like My
Computer and My Documents are now available under the Start Button. Control
panel also has been re-organized and given a new look,

Smart Tags

In this latest version of the software, XP attempts to further sense and
respond to what you are doing in a document. If you perform an operation that
could be handled more than one way, a smart tag appears. When you click on the
smart tag your options appear and you can just click on one of them. For instance,
if you are pasting text from one document into another a smart tag will appear.
What it wants to know is if you want to keep the same formatting or match the
pasted text to the formatting of the destination document. Whenever you do
something that could be completed in more than one way you will see a smart tag.

Double Down Arrow

The standard tool bar has drop down menus. When you click on the File menu it
drops down so that you can see what is in it. A change has been made in this version
of XP where they show you the most commonly used items on the menu and then
hide the rest. On the bottom of the list is a double arrow pointing down. Click on it
to expand the list and see everything in the menu.

If you would rather see everything each time click on the Tools menu and then on
Customize. Under the Options tab place a check next to Always show full menus.
When you click OK, that changes your menus. They will now open completely each
time.

Copyright © 2004 i3 Inc. inspiring, innovative, integration Appendix



Curriculum & Technology Integration Training -48 -

Software Helper
Word Processing Basics with MS Word

Formatting Text- change the font, size, and style by clicking on Format and font
or on the top tool bar.

Spacing Text- Click on Format and Paragraph

Bullets- To automatically start bullets, create an asterisk before your statement
and then press return. The next line will automatically make a bullet. To create
custom bullets, select the text you wish to appear bulleted. Click on Format and
Bullets and Numbering, Word will now insert bullets for the text that you selected.

Viewing Options-

» Normal gives you 100%

Online Layout helps you see other areas of your document at the same time.
Page Layout allows you to see the entire width of the page.

Outline allows you to see your document in an outline form.

Master Document allows you to organize and maintain a long document by
dividing it up into sub documents.

YV V V V

Viewing Toolbars- To see a toolbar that is not visible, click on View and Toolbar
and select the toolbar that you wish to see.

Header/Footers- Headers and Footers make it possible to have the same text
appear on each page. You can create a header and footer for y our document by
clicking on View and Header and Footer. They can include both text and graphics
and are great for page numbers, date, logo, etc.

Page Numbers- Click on Insert and Page Numbers. Choose your justification.
Symbols- Click on Insert and Symbols to add symbols like ®™{ and more!
Columns- Great for newsletters! Click on format and Columns. Select the option

that you want from the top and click on Line Between if you want Word to draw a
line separating the columns.
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Footnotes- Put your cursor where you want the footnote to appear. Click on
Insert and Footnote. Word automatically numbers your footnote and you can type
in your text at the bottom of the screen.

Auto Format- Choose Auto Format from the Format menu. Click on the type of
document that you wish to replicate and click Auto Format now. Word will now
change the format of your document to match the pre-set preferences of the
template that you chose.

Style Gallery- Once your document is formatted, click on Style Gallery from the
Format menu. This gives you access to different designs for your document. You
can see a preview of each style in the box to the right.

Inserting Text and Graphics:

Adding Graphics- Click on Insert and Picture.

> Clip Art- Choose this to look through the library of graphics within the program.

> From File- Choose this to get art from a clip art disk or pictures that you have
downloaded form the Internet.

> Auto Shapes- This will allow you o choose pre-made shapes. The button on the
bottom of the drawing toolbar will do the same thing.

> Word Art- Allows you to make banner-type headlines.

» Chart- Make custom charts to add to your word processing document.

Adding Text Boxes- This is useful if you are using many graphics and want to

contain your text to a certain portion of the page. You can size text boxes by

clicking on the little boxes around the text.

Drawing- You can draw your own shapes by clicking on the tools along the bottom

of the screen on the drawing toolbar. If your toolbar is not visible, click on View

and Toolbars to select the drawing toolbar.

> Draw: Click on the draw menu at the bottom to rotate, align or move shapes.

Arrow: Click on the arrow to select clip art and graphics

Auto Shapes: This option allows you to create custom shapes

Line: Create your own lines. To make a line straight, press the shift key while

you draw.

Arrow: Allows you fo draw arrows.

Rectangle/Oval Tools: Draws shapes. To make a perfect circle or square, press

your shift key while you draw.

> Text Box: Creates a box for text. You can move text boxes around like
graphics and art.

> Word Art Tool: Use this to make creative headings for your papers.

Y V V

Y VY
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> Fill Color: Create a fill color for shapes and graphics that you have created.

> Paint Brush: This will change the color of lines that you draw.

> Font Color: Change the color of the font. You will need to select the text

before choosing the font color to change the existing text.

Text Wrap- Choose Page Layout from the View menu. Click on the graphic that
you wish to wrap your text around. Open the Format menu and select the type of
graphic you are working with. Click on the Wrapping tab and make your selection.

Other Word Features:

Wizards and Templates: Click on File and New to see the built in templates. Click
once on the document you wish to see and a preview will show on the right hand
side of the screen. Use wizards and templates for the following things:

>

YV V V VY

Keyboard Shortcuts:
Use keyboard shortcuts for quick and easy access:

Letters
Faxes
Memos
Resumes
Reports

Cut

Copy
Paste
Undo
Select All
Bold
Ttalic
Underline
Left Align
Right Align
Center
Justify

Appendix

Crtl + X
Crtl + C
Cril +V
Crtl+Z
Cril + A
Crtl + B
Crtl+1I
Crtl+U
Crtl+L
Crtl +R
Crtl + C
Crtl+J
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General Word Processing Tips

» Only hit return at the end of a paragraph.
> Avoid using all caps.

> Titles should be larger than the body of your document and can be in sans serif
font. Be creative with your style.

> Rarely underline. Use italics for titles.

> Use tabs to align fext- not the space bar!

> Indent or use space between the paragraphs- but not both.

» Add pizzazz to lists by adding bullets or symbols.

» Generally, use not more than two fonts on a page.

> Use italic and bold as rich desserts- fine occasionally, but easy to overdose.

> For signifying A.M. and P.M., use capital letters, periods, and font one size
smaller than the rest of the document.

> Avoid abbreviations in addresses, except for states.
> Allow for white space in your document.

> To avoid widows and orphans, try making your top and bottom page margins
and/or your font smaller.

> Use a spelling checker.
> Always proofread a printed copy of your work.

Print a duplicate copy of your work in gray scale, so you can see how it will look if
you plan to duplicate it on the copy machine.
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